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q_id



q_desc



op1



op2



op3



op4



ans



Input, Processing, Output, Sequencing



Input, Programming, Output, Sequencing



A



BC1



IPOS stands for ________________.



Input, Processing, Output, Storage



Input, Programming, Output, Storage



BC2



Data that has been made meaningful and useful is called _____________.



Process



Information



Input



Output



B



BC3



A megabyte equals approximately ___________ bytes.



One thousand



One million



One billion



One trillion



B



BC4



_____________ transforms a computer into a terminal, which can connect to a multiuser computer system.



Word processing software



Graphics software



Telecommunication s software



Database



C



BC5



____________ are the steps that one must follow to accomplish a specific computer-related task.



Programs



Procedures



Policies



Guidelines



B



BC6



In a mainframe computer system, a ____________ processor is responsible for handling data retrieval operations.



Host



Front-end



Backend



None of the above



C



BC7



The ______________ has sometimes been called a 'supermicro'.



Workstation



Microcomputer



Mainframe



Minicomputer



A



BC8



Video game players use _________________.



Portable computers



Embedded computers



Smart cards



PDAs



B
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BC9



Second generation computers were programmed using ________________.



Low-level language



C



BC10



In ALU, _______________ stores the results of arithmetic operations temporarily before they are put out to the computer's memory.



Instruction Register Program Counter



General-purpose Registers



C



BC11



The main purpose of cache memory is to ______________.



Store the results of Store the start-up calculations instructions



Accelerate the Be used as a hard computer's speed drive while keeping the price low



D



BC12



OMR stands for ________________.



Optical Mark Recognition



Optical Message Recorder



Optical Mark Reader



Optical Message Recognition



A



BC13



DIB stands for __________________.



Dual Industry Bus



Dual Independent Bus



Disk Independent Bus



Drive Independent Bus



B



BC14



Which of the following is not a General Purpose Program?



Desktop Publishing



Word Processing



TurboTax- A tax preparation package



Graphics Software



C



BC15



The full form of PCI is _________________.



Peripheral Component Industry



Peripheral Component Interconnect



D



BC16



Optical mouse uses ___________ to detect the mouse's movement.



Laser



None of the above



C



Machine language Assembly language High-level language



Public Component Personal Computer Interconnect Interconnection



Metal ball



Optical sensors



Accumulator
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BC17



Which of the following is not a characteristic of useful information?



Relevant



Timely



Accurate



Redundant



D



BC18



PMT stands for _______________.



Picture Multiplier Tube



Photo Multiplier Tube



Picture Magnifier Tube



Photo Magnifier Tube



B



BC19



Hand-held scanners are often called _____________ scanners.



Sheet-fed



Flatbed



Drum



Half-page



D



BC20



Which of the following is used in objective tests for entrance examinations?



MICR



OCR



OMR



Bar Code Reader



C



BC21



Monochrome monitors display _______ color(s).



One



Two



Three



Four



B



BC22



The full form of SVGA is ______________.



Super Video Graphics Array



D



how sharply an individual pixel appears on the screen



how densely the pixels are packed



D



Line printer



Laser printer



D



BC23



Resolution is an indication of _________________.



BC24



Which of the following is a non-impact printer?



Super Video Soft Video Graphics Soft Video Graphics Graphics Adapter Array Adapter data than can be transmitted in a fixed amount of time



the vertical distance between each pixel on the screen



Daisy-wheel printer Dot-matrix printer
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BC25



_________is an input device that can read text or illustrations printed on paper and translate the information into a form that the computer can use.



Scanner



Joystick



Keyboard



MICR



A



BC26



The full form of DVD is ________________.



Digital Versatile Disc



Digital Video Disc



Both A and B



Neither A nor B



C



BC27



Which of these is useful in transferring data from one computer to another?



RAM



ROM



Hard disk



None of the above



C



BC28



___________ printers produce letter-quality type.



Daisy-wheel



Dot-matrix



Ink-jet



Laser



A



OS1



During the Process Management functioning of an Operating System, a __________ is defined as a program in execution.



Procedure



Process



Task



Job



B



OS2



Which of the following is not a function of the operating system?



Process Management



Device Management



Arithmetic Calculations



Command Interpretation



C



OS3



In an Operating system, _______________ is the interval from the time of submission of a job to the system for processing to the time of completion of the job.



Throughput



Response Time



Turnaround Time



Completion Time



C



OS4



In an Operating system, when a process is in the suspended state, the process is ______________.



Currently able to run, but must wait until CPU becomes available



Currently waiting on I/O



Currently able to run, but for some reason the operating system



In memory, will execute in given CPU time



C
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OS5



PCB stands for ___________________.



Program Control Block



Process Control Block



Procedure Control Block



None of the above



B



OS6



In an Operating System with threads facility, what is the basic unit of CPU utilization?



Process



Task



Program



Thread



D



OS7



In Operating System, ___________ refers to the ability of a computer system to support more than one processor.



Multitasking



Multiprocessing



Multithreading



Multiprogrammin g



B



OS8



Which of the following is not achieved using a time-sharing operating system?



Data Redundancy



Reduction in CPU idle time



Quicker response time



Good computing facility to small users



A



OS9



Which file operation Is used to position the read/write pointer to a specific place in the file?



Position



Seek



Set Attributes



None of the above



B



OS10



Which of the following situation requires real-time processing?



Error in a nuclear reactor thermal power plant



Error in study material



Car breakdown



None of the above



A



OS11



Which of the following is the Sun Microsystem's version of UNIX?



HP-UX



Linux



Solaris



Windows



C



OS12



Which one of the following is the most recent version of Windows operating system by Microsoft?



Windows 95



Windows 7



Windows 98



Windows Vista



B
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OS13



In Windows 7, the feature ___________ automatically maximizes a window when it is dragged to the top of the screen.



Aero Peek



Aero Snap



Quick Launch



Virtual Hard Disk



B



OS14



Windows 7 is available in ____ editions.



Five



Six



Seven



Eight



B



OS15



GUI stands for _____________________.



Graphical User Interface



Gaming User Interface



Graphical User Intelligence



Generic Usage Index



A



OS16



A _________ is a list from which we can give an instruction by clicking a command.



Icon



Dialog Box



Window



Menu



D



OS17



The ___________ is the place where Windows temporarily stores the deleted files.



Start Menu



Recycle Bin



Notification Area



Trash



B



OS18



Using the feature of _____________ in Windows 7, we can capture images of screen areas.



Calculator



Math Input Panel



Sticky Notes



Snipping Tool



D



OS19



In Windows 7, _____________ feature enables the user to log on and operate the computer with a more secure standard user account.



User Account Control



Control Panel



Credential Manager



None of the above



A



OS20



Which of the following statement is false?



An operating A file is a collection Multitasking is a File management system is an of related method with is not done by interface between information multiple tasks Operating hardware and user. defined by its processes sharing System.



D
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OS21



Which of the following is not a shut-down option available in Windows 7?



Log off



Lock



Sleep



Hibernate



D



OS22



RTOS stands for _________.



Run Time Operating System



None of the above



B



OS23



In Windows 7 Taskbar shortcut menu, which of the following command displays the windows on top of each other, with the title bar of each window visible and the contents of only the top window visible?



Show windows stacked



OS24



What is the full form of DLL?



Drastic Link Library



Dynamic Link Library



Diagrammatically Linked Library



None of the above



B



OS25



Which of the following is not a valid execution state in the lifespan of a process?



Executing



Waiting



Charged



Blocked



C



OS26



To improve the performance of a computer system, it is desirable to maximize __________.



Throughput



Turnaround Time



Response Time



Completion Time



A



OS27



In Operating System, which of the following is not contained in a Process Control Block?



Process Identifier



Process State



Program File Name Program Counter



C



OS28



In Operating System, threads in multithreading refer to ______________.



Real Time Real Time Operating System Operational Source



Show windows side Cascade windows Show the desktop by side



Different parts of a Different programs Different processes single process



Different users' processes



C



A
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OS29



In case of ___________ operating system, the user views the system as a 'Virtual Uniprocessor'.



Distributed



Centralized



Network



Real-time



A



OS30



The version of DOS shipped with IBM's PCs was called _________.



MS-DOS



PC-DOS



IBM-DOS



None of the above



B



OS31



Which of the following is not a feature of Windows 7 operating system?



Media Management



Communication tools



Games



Windows Calendar



D



OS32



What is the full form of RDP in windows 7?



Region Desktop Protocol



Remote Desktop Protocol



Remote Data Protocol



Real-time Desktop Protocol



B



Update Pack



Service Pack



Service Patch



C



OS33



A/An ______________ is a collection of updates, fixes and/or enhancements to a software program delivered in the form of Microsoft update a single installable package.



WO1



In MS Word 2010, which of the following is not a view provided by the Navigation Pane?



Headings View



Thumbnail Page View



Search Results View



Snapshot view



D



WO2



In MS Word 2010, _______ is a large area just below the ruler where the desired content can be inserted.



Ruler



Text Area



Title Bar



None of the above



B



WO3



In MS Word 2010, ________ displays the title of the document on which we are currently working.



Title Bar



Text Area



Ruler



Header



A
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WO4



Which of the following is a "Protect Document" option available in MS Word 2010?



Mark as Final



Encrypt with Password



Restrict Editing



All of the above



D



WO5



In MS Word 2010, which of the following is not a type of the issues detected by the "Accessibility Checker"?



Error



Warning



Threat



Tip



C



WO6



In MS Word 2010, an Accessibility ________ is given for content that in most, but not all, cases makes a file difficult for people with disabilities to understand.



Error



Warning



Threat



Tip



B



WO7



In MS Word 2010, a ____________ is a preset document layout with a collection of styles which are saved to a file and can be applied to other documents.



Template



Screenshot



Style



Agenda



A



WO8



In MS Word 2010, which of the following option is not available in the Insert Toolbar?



Tables



Illustrations



Home



Symbols



C



WO9



In MS Word 2010, _____ option automatically resizes the table to fit in a Web browser window when we change the window size.



Autofit to window Fixed column width



Fixed row width



Autofit to contents



A



WO10



In MS Word 2010 Tables, the option ________ deletes the entire column of the table where we clicked in.



Delete entire row



Delete entire column



Shift cells left



Shift cells right



B



WO11



In MS Word 2010, which of the following is not an option in the Illustrations group of the Insert Ribbon?



Picture



Chart



Screenshot



Font



D
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op2



op3



op4



ans



WO12



In MS Word 2010, ________ is the ratio between picture width and picture height which can be maintained even when resizing a picture.



Resolution



Aspect Ratio



Pixel width



None of the above



B



WO13



In MS Word 2010, a _________ identifies a location or a selection of text that we name and identify for future reference.



Template



Threat



Bookmark



Screenshot



C



WO14



Which of the following is a group under the Mailings Ribbon of MS Word 2010?



Create



Start Mail Merge



Finish



All of the above



D



WO15



In MS Word 2010, the option of _____ lets the user to flip, rotate, move or resize all shapes or objects at the same time as though they were a single shape or object.



Cropping



Grouping



Editing



Ungrouping



B



WO16



In MS Word 2010, ______ helps in selecting individual objects to change the order and visibility of objects in the document.



Selection Pane



Navigation Pane



Screenshot



None of the above



A



WO17



In MS Word 2010, a ______ is a series of commands that we can use to automate a repeated task, and can be run whenever we have to perform the task.



Symbol



Macro



Equation



None of the above



B



WO18



In MS Word 2010, which of the following is a group under Page Layout tab?



Themes



Page Setup



Page Background



All of the above



D



None of the above



D



WO19



Count the number Count the words as Count the number In MS Word 2010, which of the following is an invalid option? of words in a text we type of pages box



q_id



q_desc



op1



op2



op3



op4



ans



WO20



In MS Word 2010, which of the following is not an option under Captions group in References Ribbon?



Insert Table of Figures



Update Table



Cross-Reference



Formula Bar



D



WO21



In MS Word 2010, which of the following sequence of steps need to be followed to write an equation?



Data -> Sort -> Equation



A



WO22



In MS Word 2010, ______ is a gallery where we can create, store, and find reusable pieces of content, including AutoText, document properties and fields as displayed.



Themes



WordArt



C



WO23



In MS Word 2010, when we open a document, it may be in any of the following modes.



Word 2010



WO24



In MS Word 2010, the extension "rtf" stands for ___________.



Reversible Text Format



Rich Text Format



Return Text File



Return Text Figure



B



WO25



In MS Word 2010, _____ allows the user to copy multiple text and graphical items from Office documents or other programs and paste them into another Office document.



Clipboard



Format Painter



Macro



Navigation Pane



A



WO26



In MS Word 2010, the option ______ makes the selected text appear to be raised off the page in relief.



Outline



Emboss



Engrave



Subscript



B



WO27



In MS Word 2010 Table, the shortcut key to move to the last cell in column is __________.



Alt + End



Shift + Tab



Alt + PgDn



Alt + PgUp



C



Insert -> Symbols -> Page Layout -> Size - View -> Page Layout Equation > Equation -> Size -> Equation



Macro



Quick Parts



Word 2007 Word 97-2003 All of the above Compatibility Mode Compatibility Mode



D
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ans



WO28



In MS Word 2010, a _____ is a list of sources, usually placed at the end of a document that we consulted or cited in creating the document.



Bookmark



Bibliography



WordArt



SmartArt



B



WO29



In MS Word 2010, ____ lists the references in a legal document, along with the numbers of the pages the references appear on.



Bookmark



Bibliography



WordArt



Table of Authorities



D



WO30



In MS Word 2010, _____ view displays the final document with all tracked changes and comments showing.



Final



Original Showing Markup



Final Showing Markup



Original



C



WO31



In MS Word 2010, which of the following option is invalid under Changes group in Review Ribbon?



Accept



Reject



Next



First



D



WO32



In MS Word 2010, which of the following option is present in the Compare drop-down menu under Compare group in Review Ribbon?



Compare



Combine



Show Source Documents



All of the above



D



WO33



In MS Word 2010, ____ effect makes the selected text appear to be imprinted or pressed into the page.



Outline



Emboss



Engrave



Subscript



C



WO34



In MS Word 2010, under which tab the option Start Mail Merge is available?



Page Layout



View



Mailings



Home



C



WO35



In MS Word 2010, which of the following option is not available in the Links group on the Insert Ribbon?



Hyperlink



Bookmark



Cross-reference



SmartArt



D



q_id



q_desc



op1



op2



op3



op4



ans



WO36



Which of the following is not a valid Document View in MS Word 2010?



Web Layout



Live Preview



Outline



Draft



B



WO37



____ is a fixed layout electronic file format that preserves document formatting and enables file sharing in MS Word 2010.



UDS



XLS



DOC



PDF



D



WO38



In MS Word 2010, which option is not available under the Proofing Group on the Review Ribbon?



Spelling & Grammar



Research



Word Count



Mark Citation



D



WO39



In MS Word 2010, _______ option in Text group under Insert Ribbon inserts the date and time in the Word document.



Date & Time



Signature Line



Object



None of the above



A



WO40



In MS Word 2010, the shortcut key that is used to insert a hyperlink is ________.



Ctrl + K



Ctrl + H



Ctrl + M



None of the above



A



WO41



In MS Word 2010, to remove the Drop Cap from a paragraph that contains the Drop Cap, follow these steps.



Highlight the paragraph that contains the Drop Cap, Click Text ->



WO42



In MS Word 2010, which of the following statements is false?



A ruler spans on top of the Word document.



WO43



In MS Word 2010, a ______ is a translucent image that appears behind the primary text in a document.



Bookmark



Highlight the Highlight the Highlight the paragraph that paragraph that paragraph that contains the Drop contains the Drop contains the Drop Cap, Click Insert -> Cap, Click Insert -> Cap, Click Margins define the Themes have a None of the amount of white palette of 12 above space that appears colors. at the top, bottom, Watermark



Bibliography



None of the above



B



D



B
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WO44



In MS Word 2010, the ______ option under Arrange group on the Page Layout Ribbon lets the text flow around the image and hugs its shape.



Square



Through



Tight



Behind Text



C



None of the above



B



The Headings view under Navigation Pane provides a



C



Macro name must Macro name must not contain any not contain any All of the above space. unusual characters.



D



WO45



In MS Word 2010, which of the following statement is true?



The TextArea is an The horizontal area where the scrollbars are used desired text can be to move up and inserted. down the An embedded AutoText is a A macro once object can be reusable content created can never created in a Word that we can store be deleted. document. and access again The TextArea is a large area just above the ruler.



WO46



In MS Word 2010, which of the following statements is false?



WO47



In MS Word 2010, which of the following statement is true?



Macro name must begin with a letter.



WO48



The ____ feature of MS Word 2010 is used to create a set of documents, such as forms, envelopes, letters etc. to be sent to many customers.



Macros



Format Painter



Spell Checker



Mail Merge



D



WO49



In MS Word 2010, ____ is the keyboard shortcut key to open an existing document.



Ctrl + O



Ctrl + S



Ctrl + V



Ctrl + Alt + A



A



WO50



In MS Word 2010, the shortcut key to use Format Painter is ______.



Ctrl + Alt + C



Ctrl + Tab + C



Ctrl + Shift + C



Ctrl + Alt + A



C



WO51



In MS Word 2010, the shortcut key to go to the File tab is ______.



Ctrl + F



Alt + F



Shift + F



None of the above



B



q_id



WO52



q_desc



op1



Suppose we have a Word document containing four pages and we are printing five copies of it. Now we want them in the Print them collated page 1-4 order for each of the five sets. What is to be done in the following situation?



op2



op3



op4



ans



Print them uncollated



Print them with Portrait orientation



Print them with Landscape orientation



A



WO53



The 'x' in the docx file extension stands for _____.



XPS



XHTML



XML



XCESS



C



WO54



In MS-Word 2010, a _________ is a combination of characters that is written as a glyph, which is written as though it is a single character.



Ligature



Font



Style



Template



A



WO55



In MS-Word 2010, which of the following option is available under Paragraph group of Home tab?



Bullets



Indentation



Sort



All of the above



D



WO56



In MS-Word 2010, under various Add-In Categories option, the "Document Related Add-Ins" are the ____________________________.



Add-Ins registered Add-Ins present on Add-Ins Template files and currently our computer but automatically referred to by open running in our not currently disabled because documents Office program loaded it causes Office



B



WO57



In MS-Word 2010, the ___________ macro runs when Word Is opened.



AutoOpen



AutoExec



AutoNew



None of the above



B



WO58



Which of the following is the shortcut key to select an entire MS-Word 2010 document?



Ctrl + S



Ctrl + C



Ctrl + A



Ctrl + M



C



WO59



In MS-Word 2010, which SmartArt graphic should be used to create an Organization Chart?



Process



Hierarchy



Pyramid



Any of the above



B
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WO60



In MS-Word 2010 document, the red wavy underline indicates ______________.



Spelling errors



Grammar errors



Address Block



None of the above



A



WO61



The task of changing the appearance of a Word 2010 document is referred to as __________.



Editing



Proofing



Inserting



Formatting



D



WO62



In MS-Word 2010, the insertion point in a table can be moved using ______________ key(s).



Tab



Shift + Tab



Arrow



All of the above



D



WO63



In MS-Word 2010 document, which key deletes a character to the right of the cursor?



End



Delete



Home



Backspace



B



WO64



_____________ commands are used to move selected text from one place to another in a MS-Word 2010 document.



Move and Paste



Copy and Paste



Cut and Paste



Delete and Paste



C



WO65



By default, on which page of a Word 2010 document, the header or the footer is printed?



On first page



On last page



On every page



On alternate page



C



WO66



Which of the following can be achieved using Mail Merge in MS-Word 2010?



A set of Labels or Envelopes



Different sets of templates



A set of form letters, email messages, or fax



A set of numbered coupons



B



WO67



In MS-Word 2010, which simplifies the process of formatting text if the same formatting is required in more than one location?



Auto Text



Format Painter



Font dialog box



None of the above



B



q_id



q_desc



op1



op2



op3



op4



ans



WO68



Which is true when we insert an Excel worksheet into a Word document?



Word is the destination document



Excel is the destination document



The worksheet is the destination document



The document is the source document



A



WO69



In MS Word 2010, an __________ lists the terms and topics that are discussed in a document, along with the pages that they appear on.



Hyphen



Bibliography



Bookmark



Index



D



WO70



In MS-Word, AutoText and AutoCorrect are _________ tools.



Styling



Editing



Designing



None of the above



B



EX1



VBA stands for ______________________.



Visual Basic for Applications



Visual Basic for Abacus



Visual Basic Appliances



None of the above



A



EX2



The Excel 2010 worksheet contains _______ columns.



10,000



26,284



16, 000



16,384



D



EX3



Formulas in Excel 2010 usually begin with _____.



=



+



-



%



A



EX4



A cell reference in a MS Excel 2010 spreadsheet can refer to _________________.



A cell in a different sheet within the same spreadsheet



A cell in another spreadsheet entirely



A value from a remote application



All of the above



D



EX5



In Excel 2010, a cell on a different sheet of the same spreadsheet is addressed as _______________.



:



$



!



@



C



q_id



q_desc



op1



op2



EX6



Full form of OLE is __________________.



EX7



Keyboard shortcut to show a shortcut menu in MS Excel 2010 is _______________.



Shift + F10



Shift + F1



EX8



Keyboard key in Excel 2010 to close the visible menu, or, with a submenu visible, close the submenu only, is _________.



Home



Alt



IN24



Internet bookmarks are _________________.



Stored URLs that can be retrieved



IN25



___________ web sites are used to preserve valuable electronic content threatened with extinction.



Blog



IN26



URL stands for ________________________.



IN27



A search engine operates in the following order:



IN28



The Starter button in the File/Edit toolbar of Navigator Gold 2.0 ____________.



op3



op4



ans



Outward Linking Exchange



A



Shift + F11



Shift + F12



A



End



Esc



D



None of the above



A



Affiliate



Flash



B



Ubiquitous Resource Locator



Useful Resource Locator



A



Web crawling, Indexing, Searching



D



Object Linking and Object Loading and Object Linking and Embedding Embedding Exchange



Web pages that are Links that connect hosted on one or to other web pages more web servers



Archive



Uniform Resource Universal Resource Locator Locator



Web crawling, Indexing, Web Indexing, Searching, Searching, Indexing crawling, Searching Web crawling Opens the document in the browser window



Displays Starts to search for Prints the current information about text in the current document web creation document



B



q_id



q_desc



op1



op2



op3



op4



ans



IN29



Which of the following is not a limitation of Navigator Gold?



Editor window does not display tables.



Forms support in editor window is not stable.



JavaScript capabilities are limited.



Drag and drop capability is not supported.



D



IN30



In Internet, ______ refers to a specification by which programs can communicate with a Web server.



AJAX



CGI



CSS



HTML



B



IN31



A device that connects the computer to the Internet is __________.



Browser



Modem



Network Neighbourhood



None of the above



B



IN32



Sending unwanted e-mails in bulk is known as _____________.



Pornography



Spamming



Virus threat



None of the above



B



IN33



_________ is a program or a tool that helps in locating a file anywhere on the Net.



Archie



Veronica



Jughead



None of the above



A



IN34



________ is a network protocol used to transfer data from one computer to another through a network.



Telnet



SMTP



FTP



IRC



C



IN35



________ is a small tool to extract links/files from one or multiple website or directory listings and save them to a specified directory.



Webcow



ScanDL



LeechGet



LeechGet2001



A



IN36



In the Internet address http://mail.icai.org, the domain name is __________.



http



mail



icai



org



C



q_id



q_desc



op1



op2



op3



op4



ans



IN37



________ is a document containing words that connect to other documents.



Hyperlink



HyperText



Webpage



Website



B



IN38



______ server presents its contents as a hierarchically structured list of files.



POP



IMAP



Gopher



None of the above



C



IN39



ICMP and ARP protocols work in ____ layer of OSI reference model.



Physical



Data Link



Network



Transport



C



IN40



Which of the following is not an advantage of Internet?



Faster and more reliable communication



Information availability



E-Commerce



None of the above



D



IN41



VAN stands for ______________.



Value Addition Network



Valid Addition Network



Value Added Network



None of the above



C



EDI document



B



IN42



In EDI, a/an _________contains one or more documents for Internal Format File Transmission File External Format File the same trading partner.



IN43



In EDI, ____ is a standard protocol for securing credit card transactions over insecure networks, specifically, the Internet.



NET



CAT



https



SET



D



IN44



______ involves the electronic movement of funds and fund information between financial institutions.



ATM



EFT



Credit Cards



EDI



B



q_id



q_desc



op1



op2



op3



op4



ans



IN45



Online advertising can be categorised in two types, these are ______________.



Broadcast and billboard advertising



Web based and portal based advertising



Internal and external advertising



Active and Passive advertising



D



EX9



Excel 2010 gives a ____ extension to the template file.



.xlsx



.xltx



.dotx



None of the above



B



EX10



In Excel 2010, use _____ to move up to the row above.



Tab



Shift + Tab



Enter



Shift + Enter



D



EX11



Which function is used in Excel 2010 to enter current date under the tab Date & Time?



Date



CurrentDate



Today



Workday



C



EX12



To delete selected rows in Excel 2010, click the arrow next to Delete in Cells group in Home Tab, and then click ______________.



Delete



Delete Rows



Delete Sheet Rows



None of the above



C



EX13



To copy data to a different sheet in Excel, press ______________ while dragging the selection to the sheet's tab.



Ctrl + Enter



Shift + Tab



Ctrl + Alt + N



Ctrl + Alt



D



EX14



Keyboard shortcut to save a workbook in Excel 2010 is _____.



F10



F11



F12



F13



C



EX15



References to cells in other workbooks of MS Excel 2010 are called __________.



Links



Hyperlinks



Connections



Relative Cell References



A



q_id



q_desc



op1



op2



op3



op4



ans



EX16



To fix the formula in a cell so that absolute cell reference is used, _____ key is used in Excel 2010.



F1



F2



F3



F4



D



EX17



In Excel 2010, when E$5 is copied across, the __________ reference can change.



Row



Column



Either A or B



Both A and B



B



EX18



In Excel 2010, a range is defined by the addresses of two opposite corner cells separated by a _________.



Colon



Semicolon



Comma



Dot



A



EX19



Which of these is a valid range name in Excel 2010?



A12



A$12



___A.B



1a



C



Use the Define Use the Name Box Name command Create a name from All of the above in the Formula Bar from the Formulas a row or column Ribbon



EX20



How to name a range in Excel 2010?



D



EX21



While creating range names from a row or column, if the label for a column or row contains spaces, Excel replaces the space with a/an ___________.



Hyphen



Caret



Underscore



Asterisk



C



EX22



Which operator is used for exponentiation in Excel 2010?



Asterisk



Caret



Forward slash



Backslash



B



EX23



In Excel 2010, ___________ are structured programs that calculate a specific result.



Functions



Formulas



Ranges



Equations



A



q_id



q_desc



op1



op2



op3



op4



ans



EX24



______ category of functions in Excel 2010 searches for and returns values from a range.



Logical



Information



Engineering



Lookup and reference



D



EX25



In Excel 2010, FACT(2.9) returns __________.



2



4



6



Error #NUM!



A



EX26



In Excel 2010, LOG function returns the ________.



Natural logarithm of a number



Logarithm of a number to a specified base



EX27



In Excel 2010, MOD(-5, -3) returns _______.



2



-2



-3



-4



B



EX28



In Excel 2010, MROUND(1.3, 0.2) returns _______.



1.4



1.2



1.3



1.5



A



EX29



In Excel 2010, __________ returns the average of the absolute deviations of data points from their mean.



AVEDEV



VARA



COVAR



STDEV



A



EX30



In Excel 2010, _________ error message is given if the formula contains a reference to a non-existent cell.



#NAME?



#Value



#####



#REF!



D



EX31



The process of examining a MS Excel 2010 worksheet for errors in formulas is referred to as ____________.



Checking



Auditing



Inspecting



Assessing



B



Base-10 logarithm Base-2 logarithm of a number of a number



B



q_id



q_desc



op1



op2



op3



op4



ans



EX32



In Excel 2010, _________ error message is given if the formula contains text that Excel doesn't recognize.



#NAME?



#REF!



#####



#DIV/0!



A



EX33



To manually calculate all the formulas in a worksheet of MSExcel 2010, press _______.



F6



F7



F8



F9



D



EX34



To have column and row headings visible while scrolling the worksheet of MS Excel 2010, _______________ feature is used.



Splitting Panes



Freeze Panes



Radar Panes



Format



B



EX35



Keyboard shortcut to open Format Cells dialog box in Excel 2010, is _______________.



Ctrl + F



Ctrl + 1



Ctrl + Alt



Ctrl + 0



B



EX36



To define a table in MS-Excel 2010, select a cell in the data set and press ___________.



Ctrl + T



Ctrl + L



Either A or B



Neither A nor B



C



EX37



In Excel 2010, if a row is selected and Delete key is pressed, ____________________________.



EX38



By default, MS-Excel 2010 aligns text to the ________ of the cell.



Left



Center



Right



Justified mode



A



EX39



While wrapping text in Excel 2010, the number of wrapped lines is dependent on ___________________.



The width of the column



The length of the cell contents



Both A and B



Nothing



C



The contents of the The contents of the The contents of the The row is row are cleared but row are cleared as row are cleared as removed and the the emptied row well as the row is well as the row is contents are remains in place removed but the removed and the moved in the



C



q_id



q_desc



op1



op2



op3



op4



ans



EX40



If cells A2, A3, B2 and B3 in a worksheet of MS Excel 2010 are merged, the cell reference for the merged cell is _______.



A2



A3



B2



B3



A



EX41



A _____________ chart in Excel, shows the relationship of individual items to the whole, comparing the contribution of each value to a total across categories.



Clustered Column



Stacked Column



100% Stacked Column



3-D Column



B



EX42



In MS-Excel 2010, a 3-D column chart uses three axes - a horizontal axis, a vertical axis, and a ________ axis.



Depth



Length



Breadth



Width



A



EX43



Volume-open-high-low-close subtype of stock charts in Excel 2010, requires _____ columns of data.



3



4



5



6



D



EX44



In Excel 2010, a ____ is useful when user wants to find optimum combinations between two sets of data.



Surface Chart



Area Chart



Doughnut Chart



Bubble Chart



A



EX45



In Excel 2010, a 3-D surface chart without color is called a ___________ 3-D surface chart.



Wired



Contour



Wireframe



None of the above



C



EX46



In Excel 2010, if user wants to create a hyperlink to a specific location in the file or on the Web page, click _________ in the Insert Hyperlink dialog box.



Current Folder



Recent Files



Bookmark



Browse the Web



C



EX47



When a record is deleted using a data form in Excel 2010, ________________________.



It doesn't get deleted



Whether the deletion is permanent or temporary is



C



It gets deleted but It gets deleted and it can be restored cannot be restored



q_id



q_desc



op1



op2



op3



op4



ans



EX48



In Excel 2010, user can add a _____ to the table, which is a special row in a list that provides a selection of aggregate functions useful for working with numerical data.



Table row



Total row



Aggregate row



List row



B



EX49



In Excel 2010, the user can sort up to _____ levels using the Sort dialog box.



1



2



3



4



C



EX50



In Excel 2010, the default criteria setting for AutoFilter in each field is __________.



Top10



Bottom10



Top half



All



D



EX51



Subtotal option is in __________ group of Data tab in Excel 2010.



Sort & Filter



Outline



Data Tools



Calculation



B



EX52



External data source for an Excel 2010 workbook can be _________________.



A text file



A database



An OLAP cube



All of the above



D



EX53



Which of the following cannot store connection information of an external data source in Excel 2010?



Workbook



.odc file



.htm file



.udcx file



C



EX54



UDC stands for _______________________.



Ubiquitous Data Connection



Universal Data Connection



Universal Data Continuity



User Digital Connection



B



EX55



The default pivot chart type in Excel 2010 is a ________ chart.



Column



Line



Scatter



Bubble



A



q_id



q_desc



op1



op2



op3



op4



ans



EX56



Macros option is in Code group of ____________ Ribbon in Excel 2010.



Insert



Data



Home



Developer



D



EX57



_________ is not a type of sparkline in MS-Excel 2010.



Line



Row



Column



Win/Loss



B



EX58



In a PivotTable report in Excel 2010, nonnumeric fields are added to the ________________ area of the layout section, by default.



Row Labels



Column Labels



Values



Report Filter



A



EX59



__________ are easy-to-use filtering components that enable the user to quickly filter the data in a PivotTable report in MSExcel 2010.



Sparklines



Slicers



Macros



Data Forms



B



EX60



In Excel 2010, ___________ function is used to create validation based on dependent drop-down lists.



DIRECT



DEPENDENT



INDIRECT



LOOKUP



C



EX61



In Excel 2010, range C3:C6 indicates _______________.



None of the above



A



EX62



The first cell in an Excel 2010 worksheet is labeled as ____.



AA



A1



A0



1A



B



EX63



In Excel 2010, which function is used to return the remainder after a number is divided by a divisor?



ROUND



FACT



MOD



DIV



C



Cells C3 through C6 Cell C3 and Cell C6 Cell C4 and Cell C5



q_id



q_desc



op1



op2



op3



op4



ans



EX64



Microsoft Excel 2010 is a powerful ____________.



Spreadsheet package



Communication software package



Word processing package



DBMS package



A



EX65



In Excel 2010, which of the following is Text Concatenation operator?



"



!



#



&



D



EX66



To select multiple non-adjacent cells in an Excel 2010 worksheet, click them holding _________ key.



Ctrl



Alt



Shift



Ctrl + Shift



A



EX67



If we want to sort an employee file so that they would be listed alphabetically by last name and first name within individual zip codes (smallest to largest), which of the following would be the correct sorting order?



Zip codes (ascending), then last name (ascending), then



Last name (ascending), then first name (ascending), then



Zip codes (descending), then last name (ascending), then



Last name (descending), then first name (descending),



A



EX68



A quick way to return to a specific area of a worksheet in Excel 2010 is to type the cell address or range name in the ____________.



Name Box



Formula Bar



Zoom Box



Sheet Tab



A



EX69



In MS-Excel 2010, the Name Box shows the ________________________.



Formula in the cell currently working on



C



EX70



We want to set such that when we type Baishakh and drag the fill handle, Excel should produce Jeshtha, Aashadh and so on. What should we set to effect that?



Custom List



AutoFill Options



Fill Across Worksheet



Fill Series



A



EX71



In Excel 2010, what is represented by the small black square in the lower-right corner of an active cell or range?



Copy handle



Fill handle



Insert handle



Border



B



Name of the Name of the Name of the cell or worksheet workbook currently range currently currently working working on working on on



q_id



q_desc



op1



op2



op3



op4



ans



EX72



If we want all of the white cats grouped together in an Excel 2010 worksheet of all the animals, we need to sort by _________.



Color, then Gender



Pet Type, then Color



Pet Type, then Gender



Color, then Pet Name



B



EX73



Suppose we accidentally erased a record in an Excel worksheet. Which command can be used to restore it immediately?



Insert



Replace



Paste



Undo



D



EX74



Which of the following is a valid cell address in MS Excel 2010?



96g



79 64



AB



A5



D



EX75



Which of these is the best way to show the monthly rainfall in an Excel 2010 report?



Insert a calendar



Insert a photograph of rainfall



Insert a chart showing rainfall amounts



Insert a database of rainfall



C



New



Save As



Edit



Save



B



Ascending



Descending



Alphabetical



Random



B



Table



PivotTable



Formula



Chart



C



SUM(A1:A4 ^ A3:A5)



B



EX76



EX77



Suppose you are editing a MS Excel 2010 worksheet that you had previously saved. If you want to save the edited sheet without losing the original one, which command should you use? In order to arrange the names of the students from those with the highest marks to those with the lowest in an Excel worksheet, we need to sort on the marks field in _____________ order.



EX78



In order to perform a calculation in an Excel 2010 worksheet, we need to use a ___________.



EX79



Which of the following functions would give the sum of the contents of cells A3 and A4 in MS-Excel 2010 worksheet?



SUM(A1:A4, A3:A5) SUM(A1:A4 A3:A5) SUM(A1:A4 : A3:A5)



q_id



q_desc



op1



op2



op3



op4



ans



EX80



In MS-Excel 2010, which of the following operator has the highest precedence?



Range



Union



Negation



Exponentiation



A



EX81



In MS-Excel 2010, the option to disable the printing of gridlines along with the text is available on ___________ tab of Page Setup dialog box.



Page



Margins



Header/Footer



Sheet



D



EX82



Which of the following is not a category of functions in MSExcel 2010?



Financial



Engineering



Agricultural



Information



C



PP1



A ________ is a set of colors, fonts, and special effects that provides attractive backgrounds for the PowerPoint 2010 slides.



Theme



Style



Template



Effect



A



PP2



In MS-PowerPoint 2010, which tab provides the facility to add a video and audio to the presentation?



Home



Insert



Animations



Transitions



B



PP3



Using ________ tab of Chart Tools in MS-PowerPoint 2010, we can control the chart type, layout, styles, and locations.



Design



Layout



Format



None of the above



A



PP4



Which technology provides the facility to share and edit a PowerPoint presentation by multiple users?



SharePoint Foundation 2010



Microsoft SharePoint Server 2010



Microsoft Office Live Workspace



All of the above



D



PP5



In MS-PowerPoint 2010, the ___________ option prints images that contain variations of gray tones between black and white.



Graystyle



Colorscale



Grayscale



None of the above



C



q_id



q_desc



op1



op2



op3



op4



ans



PP6



The shortcut key to start the slide show of a PowerPoint 2010 presentation is _____.



F2



F3



F4



F5



D



PP7



Any transitions in Audio is not Any animations in Video played in Which change is not observed in PowerPoint features when a the presentation transmitted to the the presentation the presentation PowerPoint 2010 slide show is broadcasted online? are shown as Fade audience through are shown as Fade is not shown to transitions in the the browser animations the audience.



C



A slide effect used The way one slide to introduce a slide looks in a slide show



C



PP8



What is a slide transition in MS-PowerPoint 2010?



Overheads



Letters



PP9



How can we exit the slide show of a MS Powerpoint 2010 presentation?



By pressing down arrow key



By pressing left arrow key



By pressing Esc key



By pressing Tab key



C



PP10



_____________ is a template used to create consistent layouts throughout the MS PowerPoint 2010 presentation.



Notes Master



Slide Master



Handout Master



Clip Art



B



PP11



In MS PowerPoint 2010, __________ tool can be used to select part of a window while taking a screenshot.



Screen Clipping



Screen Cropping



Clip Art



None of the above



A



PP12



In MS-PowerPoint 2010, which playback option should be used to play an audio clip continuously?



Automatically



Play across slides



On Click



Loop until Stopped



D



PP13



The animation effect _______ determines how an object moves around a slide in a MS Powerpoint 2010 presentation.



Entrance



Exit



Motion Paths



Emphasis



C



q_id



q_desc



op1



op2



op3



op4



ans



PP14



Slide ___________ are motion effects that occur in slideshow view when we move from one slide to the next during a MS PowerPoint 2010 presentation.



Animations



Transitions



Narrations



Views



B



PP15



While printing full page slides in a MS Powerpoint 2010 presentation, select _____________ to print a thin border around slides.



Border Slides



Frame Slides



High Quality



Scale to Fit Paper



B



PP16



The ___________________ feature in MS-PowerPoint 2010 enables presenters to share a slide show with anyone, anywhere, over the Web.



Broadcast Slide Show



Share Slide Show



Collaborate Slide Show



Feature Slide Show



A



PP17



In MS-PowerPoint 2010, the protection option ________ installs Window Rights Management service to restrict permissions to access the presentation.



Mark as Final



Encrypt with Password



Restrict Permission by People



Add a Digital Signature



C



CA1



In CAAT, a ____________ is a redundant digit that is added to a code to enable the accuracy of other digits in the code.



Valid digit



Check digit



Slab digit



Block digit



B



CA2



In Field checks under CAAT, which of the following code type lists attributes of an entity in the order of importance?



Serial code



Block sequence code



Hierarchical code



Association code



C



CA3



In Field checks under CAAT, which of the following code type has the demerit of low mnemonic value?



Serial code



Block sequence code



Hierarchical code



Association code



A



CA4



____ is the type of batch checks defined as the grand totals calculated for any code on a document in the batch.



Financial totals



Hash totals



Document totals



Record counts



B



q_id



q_desc



op1



op2



op3



op4



ans



CA5



Under Data Integrity related controls in CAAT, which of the following is not a report protocol?



Print control data for internal tables



Print run to run control totals



Print suspense account entries



None of the above



D



CA6



Under Data Integrity related controls in CAAT, which of the following is not an update protocol?



Print suspense account entries



Maintain suspense account



CA7



Under Systems tests in CAAT, in ____________ testing, individual modules are coded and tested individually and then assembled, to be tested as a whole.



Incremental



Top-down



Bottom-up



Big bang



D



CA8



In CAAT, _________ audit technique software is used by the auditor to compare the executable version of a program with a secure master copy.



Audit Software



Core Image Comparison



Database Analyzers



Program Code Analysis



B



CA9



examine dates of compare the source read and analyze Under Audit techniques, Mapping is a software used by the list unused program changes made to version of a records of auditors to ___________. instructions the executable program with a machine activity library secure master copy



CA10



The aspects of information quality include ______________.



Efficiency



System response time



Accuracy



Ease of use



C



CA11



_____________ testing is specification-based.



White box



Black box



Incremental



System



B



CA12



ITF stands for _________________________.



Incremental Test Facility



Internal Test Facility



Integrated Test Facility



Interleaved Test Facility



C



Sequence check on Ensure all records transaction and on files are master files processed



A



A



q_id



q_desc



op1



op2



op3



op4



ans



CA13



Source code which does not meet user requirements is ____________ code.



Erroneous



Unauthorized



Ineffective



Inefficient



C



Both A and B



Neither A nor B



B



CA14



Under the popular methods for randomly selecting a sample Selects transactions Selects transactions of transactions, the systematic sampling method based on a random based on a ____________________________________. number assignment sampling rate



CA15



__________________ is the process of obtaining key ratios and totals from an organization's data for comparison with previous year's ratios and totals or industry wide ratios and totals.



Functional Review



Core Image Comparison



Analytical Review



None of the above



C



CA16



___________________ are enhanced productivity tools that are part of a sophisticated operating systems environment.



Package programs



Utility programs



System Management programs



Purpose-written programs



C



CA17



__________________ includes a comprehensive series of Traditional Analysis tests designed to detect indicators of a wide range of frauds.



Transactional Analysis



Data Analysis



Fraud Analysis



B



CA18



Under System security, _______ ensures that information is not accessed by unauthorized persons.



Confidentiality



Integrity



Authentication



Privacy



A



CA19



Under System security, _________ ensures that the originators of messages cannot deny that they in fact sent the messages to the recipients.



Access control



Availability



Repudiation



Non-repudiation



D



CA20



The activity of taking backups is performed while maintaining ________.



Physical security



Operational security



System security



Network security



C



q_id



q_desc



op1



op2



op3



op4



ans



CA21



In which order the following steps are performed in an audit procedure: 1. Event Selection 2. Event Detection



1, 2, 4, 5 and 3



3, 4, 1, 5 and 2



3, 5, 1, 4 and 2



5, 1, 3, 2 and 4



A



CA22



In IDEA, _______ function is used to find the day of the week, given a date.



WEEKDAY



DAYOFWEEK



dow



day



C



CA23



Full form of PBX is _______________________.



Public Breach Exchange



Private Breach Exchange



Private Broad Extraction



Public Breach Extension



B



CA24



In IDEA, for anlyzing the data,___________ can be used to identify unusual or strange items.



Exception testing



Gaps testing



C



CA25



The Analysis ToolPak in Excel has a ___________ tool that provides the auditor with an easy way to calculate summary statistics for a set of sample data.



Statistics



Summary Statistics



Descriptive Statistics



None of the above



C



CA26



Which among the following is not a strategy for system testing?



Big bang



Incremental



Decremental



None of the above



C



CA27



Which controls are not a part of Application Controls?



Input Controls



Output Controls



Management Controls



Processing Controls



C



CA28



_________ is defined as the process of grouping together transactions that bear some type of relationship to one another.



Grouping



Batching



Range



All of the above



B



Statistical sampling Duplicates testing



q_id



q_desc



op1



op2



op3



op4



ans



CA29



In Data Analysis Techniques, _________ law is used to identify statistically unlikely occurrences of numeric data.



Benford



Benfish



Benjamin



None of the above



A



CA30



An input check that verifies that employees are paid not less than minimum wage but not more than a preset limit per hour would be a ______.



Limit check



Reasonableness check



Range check



Sign check



C



CA31



All input records in a batch might have to be of a particular type is verified in __________ type of batch checks.



Control Totals



Transaction



Sequence Check



Batch serial number



B



CA32



Functions of Generalized audit software include _______________________.



File access/File reorganization



Stratification and Statistical/Arithmet Frequency analysis ic operations functions



All of the above



D



CA33



Which of the following is not an objective of source code review?



Identifying erroneous code



Identifying unauthorized code



Identifying ineffective code



Identifying processes



D



CA34



_________________ are used by an entity to perform common data processing functions, such as sorting, creating and printing files.



Package programs



Purpose-written programs



Utility programs



System Management Programs



C



CA35



Under System security, __________ reduces the threat to information assets through fear.



Deterrence



Prevention



Recovery



Detection



A



CA36



___________ audit technique involves taking a picture of a file of data or a transaction passing through the system at a particular point in time.



Source Comparison



Snapshots



Modelling



On-line Testing



B



q_id



q_desc



op1



op2



op3



op4



ans



CA37



____________ auditing techniques cover or collect data as the transaction is being processed.



Post implementation



Concurrent



General



All of the above



B



PP18



While checking a presentation, the Accessibility Checker gives an accessibility ________ for content that people with disabilities can understand, but that might be better organized or presented in a way that would maximize their experience.



Error



Tip



Warning



Bug



B



PP19



In MS-PowerPoint 2010, ___________ view is the main editing view where we can write and design the slides of a presentation.



Normal



Slide Sorter



Slide Show



Reading



A



None of the above



D



All of the above



D



PP20



PP21



Multiple authors A user can use the Powerpoint 2010 Which of the following statement is false for MS PowerPoint can simultaneously mouse or the provides a pen and 2010 presentations? change the same keyboard to highlighter tool so presentation stored navigate through that we can write Which file format can be added to a MS PowerPoint 2010 presentation?



.gif



.wav



.jpg



Insert -> Illustrations -> Chart



PP22



A chart can be inserted in a MS PowerPoint 2010 presentation Insert -> Pictures -> Insert -> Images -> using _____________________. Chart Chart



Insert -> Symbols C > Chart



PP23



Which of the following is not a valid type of animation effects in MS-PowerPoint 2010 presentation?



Motion Paths



Exit



Entrance



Italics



D



PP24



______________ controls how the information is arranged on the slide in MS-PowerPoint 2010.



Slide Layout



Slide Transition



Theme



Slide Animation



A



q_id



q_desc



op1



op2



op3



op4



ans



PP25



To open an existing MS PowerPoint 2010 presentation, press __________.



Ctrl + A



Ctrl + N



Ctrl + M



Ctrl + O



D



DB1



Processed data is called ______________.



Datum



Information



Database



DBMS



B



DB2



The ____________ part of a database system consists of instructions and rules that govern the design and use of the system.



Hardware



Software



Data



Procedure



D



DB3



_______________ are responsible to oversee the general operations of the database system.



Database administrators



Systems administrators



End users



Database designers



B



Reduced application development time



C



DB4



Data integrity and Which of the following is not an advantage of using a DBMS? Data independence Decentralized data security



DB5



The first level of data modelling builds the conceptual model of the data, using ________.



E-R Diagram



Normalization



Physical Database



Logical Database



A



DB6



What is the cardinality of the relationship between Student and Batch?



1:1



1:N



N:1



M:N



C



DB7



In a relational database, a record is also known as a _________________.



Field



Table



Tuple



Attribute



C



q_id



q_desc



op1



op2



op3



op4



ans



DB8



Which of these is not a relational database rule proposed by Codd?



Physical Data Independence



Logical Data Independence



Distribution Independence



Conceptual Data Independence



D



DB9



In SQL, ___________ is used for query, insertion, deletion and updation of information stored in the database.



DDL



DML



DCL



DA



B



DB10



Databases created in MS-Access 2007 have the file extension _________.



.acc



.accdb



.mdb



.db



B



DB11



In MS-Access 2007, __________ modules are attached to forms or reports.



Class



Standard



Interface



All



A



DB12



In MS-Access 2007, a table's properties can be set in table's property sheet under ___________ view.



Design



Datasheet



PivotTable



PivotChart



A



DB13



Which of these is not a benefit of using relationships in MSAccess 2007?



Consistency



Comprehensibility



Ambiguity



Efficiency



C



DB14



_____________ is a web site that can be displayed in a browser and includes an interface for displaying lists and libraries in a secure database.



SharePoint



ShareLogo



ShareWare



ShareSite



A



DB15



Which character can occur in a field name in MS-Access 2007?



_



#



whitespace



$



C



q_id



q_desc



op1



op2



op3



op4



ans



DB16



When we create a new table, MS-Access 2007 automatically creates a primary key of _____________ data type.



Text



Memo



Number



AutoNumber



D



DB17



In MS-Access 2007, the table property "LinkChildFields" is used to _________.



DB18



In MS Access 2007, __________ data type fields do not offer common filters.



Number



Attachment



Hyperlink



OLE Object



D



DB19



In MS-Access 2007, filtering on a partial selection is not available for __________ fields.



Single-valued



Multivalued



AutoNumber



Attachment



B



DB20



In MS-Access 2007, when specifying in a filter text box, enclose a character in ____ to disregard its special meaning.



()



{}



[]



"



C



DB21



In database systems, _________ is a mechanism for retrieving information from a database and consists of questions presented to the database in a predefined format.



Query



Form



Report



Hyperlink



A



DB22



In MS-Access 2007, query once created using query wizard can always be modified using ____________ view.



Datasheet



Form



Design



Layout



C



DB23



In MS-Access 2007, which of the following controls can be used to insert Yahoo! Toolbar in a form?



Insert Chart



Insert Page



Insert ActiveX Control



Insert Yahoo



C



List the fields in the List the primary key Specify whether a Specify which table or query used field(s) in this table subdatasheet table or query for the that match the should appear in should supply the subdatasheet that child fields for the Datasheet view rows in the



A



q_id



q_desc



op1



op2



op3



op4



ans



DB24



In Access, __________ are procedures which get triggered on an associated activity of a control.



Commands



Events



Actions



Forms



B



DB25



In MS-Access 2007 reports, the ____________ section is used to calculate summaries for all the detail records in a group.



Group Footer



Page Footer



Report Footer



Page Header



A



DB26



In MS-Access, _____________ controls are also known as memory variables.



Bound



Calculated



Unbound



None of the above



C



DB27



In MS-Access 2007, use ____________ table property to define a criteria to display only matching rows in Datasheet view.



Filter



Filter On Load



Validation Rule



Validation Text



A



DB28



Which of the following is not a table template available in MSAccess 2007?



Contacts



Events



Assets



Liabilities



D



DB29



In database, a good database design is one that ______________________.



divides the information into subject-based tables to reduce



DB30



One should always start designing a database by first creating its ___________.



Tables



Sheets



Modules



Forms



A



DB31



Codd proposed _____ rules for a relational DBMS.



10



12



14



16



B



helps support and accommodates the ensure the data processing and All of the above accuracy and reporting needs integrity of the



D



q_id



q_desc



op1



op2



op3



op4



ans



DB32



A DBMS that supports a database distributed across several different sites is called a ______________ DBMS.



Centralized



Distributed



Multiple



None of the above



B



DB33



In MS-Access 2007, which of the following data type creates a field that allows the user to choose a value from another table or from a list of values by using a list box or combo box?



OLE Object



Memo



Hyperlink



Lookup Wizard



D



DB34



In a table, _____________ uniquely identifies each record that is stored in the table.



Unique Key



Foreign Key



Primary Key



Record Key



C



DB35



DCL provides commands to perform actions like _________.



Authorizing access and other control over database



Inserting, updating or deleting records



C



DB36



A database _______ presents summarized information retrieved from a table in a preformatted, attractive manner.



Form



Query



Macro



Report



D



DB37



In MS-Access 2007, which type of query extracts the data from one or more existing tables and puts them into separate table?



Parameter query



Update query



Crosstab query



Make Table query



D



DB38



In an MS-Access report, in which section we can keep the sum[Sales] to calculate the total sales for each month?



In the Report Header Section



In the Report Footer Section



In the Page Footer Section



In the Month Group Footer Section



D



DB39



What is the first step in creating a form or report using the Form Wizard or the Report Wizard in MS-Access 2007?



Changing the Creating views and structure of tables indexes



Selecting the fields Selecting the Reading several Selecting how the that we want to underlying table or screens of mostly form or report appear in the form query on which we useless information should be or report want to base the and clicking next formatted



B



q_id



q_desc



op1



op2



op3



op4



ans



DB40



The process of arranging data in a logical sequence is called ____________.



Classifying



Filtering



Sorting



Summarizing



C



DB41



If some chunk of data is stored at two places in a database, then ___________.



Storage space is wasted



Changing the data at one place only will cause data inconsistency



It can be more easily accessed



Both A and B



D



DB42



In MS-Access, what data type can be used for a phone number field in a database?



Number



Text



Memo



Any of the above



B



DB43



Which of the following can be a primary key in an employee database?



Employee Code



Employee Name



Date of Birth



Joining Date



A



DB44



Which of the following is a Database Management System?



Java



Oracle



Lotus 1-2-3



MS-Outlook



B



DB45



Which of the following is not a data type in MS-Access 2007?



Memo



Yes/No



Image



AutoNumber



C



DB46



In MS-Access 2007, __________ queries are best suitable to summarize information and looking for trends.



Crosstab



Parameter



Action



None of the above



A



DB47



Which of the following is not a section in Report Design view in MS-Access 2007?



Report Header Section



Page Header Section



Detail Section



Summary Section



D



q_id



q_desc



op1



op2



op3



op4



ans



DB48



Which of the following is not an action query in MS-Access 2007?



Add



Delete



Make Table



Update



A



DB49



In MS-Access 2007, which data type is best suitable for storing the price of a commodity?



Text



Number



Currency



AutoNumber



C



DB50



In MS-Access 2007,the ________ control in the form lets the user insert a picture into the it.



Title



Logo



Picture



Graphic



B



DB51



Which query should be used to retrieve the following information from table of databases "Which employees earn more than Rs.30,000 a month?"



Search Query



Make Table Query



Aggregate Query



Select Query



D



DB52



Queries in MS-Access 2007 can be used as ________________________.



Both A and B



Neither A nor B



C



View, change and A source of records analyze data in for forms and different ways reports It is a Data Entry Screen to make viewing, entering and editing data in



It is a part of database used by the analysts to draw conclusions



None of the above



B



DB53



What is a form in MS-Access?



It is a printed page where users will enter data



DB54



Which of the following degree of relationship cannot be applied in MS-Access 2007?



One-to-One



One-to-Many



Many-to-Many



None of the above



D



DB55



In an ER model, a/an ___________ is any object, place, person, event or concept about which an enterprise records data.



Entity



Attribute



Relationship



None of the above



A



q_id



q_desc



op1



op2



op3



op4



ans



MO1



The Outlook 2007 Calendar sheet is divided into ___________ increments.



One hour



Half hour



Fifteen minutes



Two hours



B



MO2



In Outlook 2007 Calendar, the ________ icon in front of an appointment indicates a private appointment.



Bell



Lock



Double arrow



Exclamation



B



MO3



In MS-Outlook 2007, AutoPick Next button is used to __________________.



Find the next time that is open to all the attendees



Find the next attendee



Find the next time that is open to a particular attendee



None of the above



A



MO4



In MS-Outlook 2007, scheduling a resource such as conference room or a slide projector for a meeting requires __________.



Microsoft Exchange



Netscape



Microsoft Office Live Meeting



All of the above



A



MO5



Refresh Free/Busy option in an Outlook 2007 group schedule ___________.



Displays the working hours specified in the schedule



Displays details of all calendar items



MO6



In MS-Outlook 2007, Folder List option is available from the __________ menu.



Go



Tools



View



Actions



A



MO7



A single Outlook 2007 user profile can contain ___________ Microsoft Exchange account(s).



One



Many



Two



Three



A



MO8



In Outlook 2007, the number next to the word "Inbox" in the The number of read The number of The total number of Folder List indicates __________________. messages unread messages e-mails



None of the above



B



connects to the Finds available server and times for all group obtains the latest members free/busy



D



q_id



q_desc



op1



op2



op3



op4



ans



MO9



Which of the following cannot be done using the Field Chooser in Outlook 2007?



Adding fields



Removing fields



Modifying fields



Rearranging fields



C



MO10



In MS-Outlook 2007, if a mailing list is moderated and _________________ is enabled, any UNSUBSCRIBE message to this list will be forwarded to the moderator.



Moderator Leave



Moderator Control Join



A



MO11



In MS-Outlook 2007, the maximum time limit for scheduling an automatic Send/Receive (for an RSS Feed) is ________.



100 minutes



60 minutes



1440 minutes



3600 minutes



C



MO12



When an e-mail message in Outlook 2007 is opened, its contents are displayed in the _______________.



Message List pane



Reading pane



Navigation pane



Folder List



B



MO13



In Outlook, the e-mail addresses should be separated with ______ if one wants to send an e-mail to multiple recipients.



Comma



Semi-colon



Colon



Percentage



B



TL1



In case of Personal Accounts, rule is _______________________.



Debit what goes out, Credit what comes in



Debit all Expenses, Credit all Income



B



TL2



Accounting in simplest terms, is keeping track of our ________________. This is true for a business, for a household or for an individual.



Income



Expenses



Assets and Liabilitites



All of the above



D



TL3



Which of the following is a basic document used in the Financial Accounting System, where transactions are entered chronologically.



Voucher



Ledger



Journal



Trial Balance



C



Moderator Control Moderator Control Leave



Debit what comes Debit the Receiver, in, Credit what goes Credit the Giver out



q_id



q_desc



op1



op2



op3



op4



ans



TL4



___________ gives the consolidated list of various accounts and their balances.



Trial Balance



Balance Sheet



P&L Report



Voucher



A



TL5



In Tally.ERP 9, we can maintain company data for ________ financial years.



5



10



20



any number of



D



TL6



In Tally.ERP 9, we cannot export the data in _________ format.



HTML



Excel



XML



ASCII



A



TL7



Tally.ERP 9 offers a data encryption option called ______________.



Tally Vault



Tally Audit



Tally Backup



None of the above



A



TL8



In Tally.ERP 9, one can delete the ledger by pressing ________ in the Alteration Mode.



Ctrl + D



Shift + D



Alt + D



None of the above



C



TL9



During voucher entry in Tally.ERP 9, we can pre-fill the voucher narration for a specific ledger/voucher entry by pressing ________.



Ctrl + R



Shift + R



Both A and B



Neither A nor B



A



TL10



In the Accounting Vouchers screen of Tally.ERP 9, press ____ to create a payment voucher.



F4



F5



F6



F7



B



TL11



In Tally.ERP9, we can pass _________for any kind of Purchase Returns,Escalation/De-escalation in price or any other expenses incurred by us on behalf of the party, etc.



Credit Note voucher



Stock Journal



Physical Stock Voucher



Debit Note voucher



D



q_id



q_desc



op1



op2



op3



op4



ans



TL12



Which of the following is not an asset?



Buildings



Cash balance



Debtors



Car Loan from Axis Bank



D



TL13



The ________ feature in Tally.ERP 9 allows the user to create multiple levels of security as per requirements.



Security Controls



Tally Vault



Backup



Tally Audit



A



TL14



In Tally.ERP 9, we use F12 function key for _______.



Features



Company Info



Configurations



Gateway of Tally



C



TL15



We can record any money received from debtors against sales invoices using _______ voucher in Tally.ERP 9.



Payment



Receipt



Contra



Sales



B



TL16



To enable Debit/Credit Notes in Tally.ERP 9, press _____ and set Use Debit/Credit Notes to Yes.



F3



F5



F8



F11



D



TL17



In the Bills Outstanding screen of Gateway of Tally, we can toggle between Payables or Receivables reports by clicking the function key______.



F4



F5



F6



F7



A



TL18



Which of the following is not a type of analytical report in Tally.ERP 9?



Cash Flow Statement



Fund Flow Statement



Ratio Analysis



Ledger



D



TL19



In accounting, a _____ is a financial statement that reports a firm's financial position at a specific time.



Balance Sheet



Cash Book



Day Book



Trial Balance



A



q_id



q_desc



op1



op2



op3



op4



ans



TL20



Which of the following is not an Account Type?



Profit



Asset



Liability



Income



A



TL21



Which of the following is not a step in Accounts compilation?



Recording



Summarising



Delimiting



Classifying



C



TL22



Which of the following is not a feature of Tally.ERP 9?



Power



Flexibility



Scalability



Redundancy



D



TL23



Which of the following is not a type of Company Features in Tally.ERP 9?



Accounting Features



Auditing Features



Inventory Features



Tally.NET features



B



TL24



In Tally.ERP 9, which key is used to select Statutory & Taxation Features in Company Features menu?



F1



F2



F3



F4



C



TL25



In Tally.ERP 9, the ____ company features consist of configurations/ functionalities, which affect accounting transactions and reports.



Statistical



Inventory



Accounting



Statutory & Taxation



C



TL26



In Tally.ERP 9, the Inventory company features are further subdivided into ____ sections.



6



7



8



9



B



TL27



In Tally.ERP 9, there are ___ predefined groups which are widely used in Chart of Accounts of many trading organizations.



28



29



30



31



A



q_id



q_desc



op1



op2



op3



op4



ans



TL28



The shortcut key to view predefined ledgers in Tally.ERP 9 is __________.



Ctrl + G



Ctrl + L



Alt + G



Alt + L



B



Sales Voucher



Contra Voucher



Bill Voucher



D



TL29



Which of the following is not a type of voucher in Tally.ERP 9? Payment Voucher



TL30



____ is an indicator of the operating performance of a business.



Ratio Analysis



Cash Flow Statement



Budgeting and Controls



Fund Flow Statement



A



TL31



_______ provides information on the difference between the actual vs the budgeted figures.



Fund Flow Statement



Variance Analysis Report



Ratio Analysis



Cash Flow Statement



B



TL32



The first document where a financial transaction is entered is called a ___________.



Voucher



Journal



Ledger



Group



A



TL33



The closing stock of finished goods is treated as an __________ in the Profit & Loss statement.



Income



Asset



Expense



Liability



A



TL34



In Accounting, the ledger accounts are usually posted every __________.



Year



Half-year



Month



Week



C



TL35



Cash A/c is an example of ________ Account.



Personal



Revenue



Real



Nominal



C



q_id



q_desc



op1



op2



op3



op4



ans



TL36



The methods LIFO, FIFO, Moving Average are used to value ______________.



Closing stock



Clearing stock



Expense stock



Opening stock



A



TL37



The Sundry Debtors are placed in the Balance sheet on the ______________.



Income side



Assets side



Expense side



Liabilities side



B



TL38



The first step in Tally.ERP 9 before any transaction is entered or saved is creating a _________.



File



Company



Project



Application



B



TL39



A payment is made to a creditor ABC - Rs.10,000 by cash, it should be entered into the ________ Voucher.



Loan



Payment



Receipt



Sales



B



TL40



The Tally.ERP 9 license file is ___________.



Tally_lck.lic



Tally.lic



Tally9.lic



lck.lic



A



TL41



Which of the following is true when a company is splitted in Tally.ERP 9?



TL42



Every financial transaction in an organization has _______ aspects.



One



Two



Three



Four



B



TL43



In Tally.ERP 9, we can pass Debit Note Voucher in Invoice mode using the shortcut key _________.



Ctrl + F8



Ctrl + V



Ctrl + G



Ctrl + I



B



The date specified The date specified One day after the One day before in the Split from in the Split from date specified in the date specified field in the Split field in the Split the Split from field in the Split from Company Data Company Data in the Split field in the Split



A



q_id



q_desc



op1



op2



op3



op4



ans



None of the above



B



TL44



Answer the If we forget the Tally Vault password in Tally.ERP 9, which of question which has the following can be done to break it? been specified as the password hint



The Tally Vault Change some of the password cannot settings of Tally be broken by any Vault to get it. means.



TL45



Which of the following is a predefined accounting voucher in Tally.ERP 9?



Contra Voucher



Payment Voucher



Receipt Voucher



All of the above



D



TL46



In Tally.ERP 9, we can pass ______________ for recording the actual stock which is verified or counted.



Physical Stock Voucher



Stock Journal



Credit Note Voucher



None of the above



A



TL47



____ in Tally.ERP 9 provides information on critical ratios (viz., Bank Reconciliation operating cost percentage, return on working capital etc.) in a Report single report.



Ratio Analysis Report



Variance Analysis Report



None of the above.



B



TL48



___________ is used to view Bank transactions for a month in Tally.ERP 9.



Day Book



Month Book



Bank Book



Bank Register



C



TL49



To view Ageing Analysis Report in Tally.ERP 9, press _____ in the Bills Outstanding screen.



F4



F6



F8



F10



B



TL50



While viewing Bank Reconciliation Statement in Tally.ERP 9, press ____ to reconcile.



F3



F5



F7



F9



B



IN1



Full form of ISP is _______________________.



Internal Service Provider



Internet Service Provider



Internet Serial Protocol



Internal Serial Protocol



B



q_id



q_desc



op1



op2



op3



op4



ans



IN2



The knowledge of _______ operating system is required to use the Internet with dial up connection.



Linux



Windows



Unix



Symbian



C



IN3



Which of these is not an ISP?



VSNL



CSC



BSNL



CMC



B



IN4



Mirror servers can be used to ____________________.



Ease the load of data transfer



Log into remote computers



Provide e-mail facilities to the users of the Internet



Search for information on the Internet



A



IN5



______________ is also known as shell accounts.



Dedicated access



Dial up access



ISP



VoIP



B



IN6



VoIP stands for ____________________.



Voice of Internet Protocol



Voice over Internet Protocol



Voice of Internal Protocol



Voice over Internal Protocol



B



IN7



_____________ is an activity allowing two or more Internet users to converse in writing in real time.



E-mail



E-commerce



Chat room



Business transaction



C



IN8



Full form of HTTP is _____________________.



None of the above



B



IN9



Which of the following is not a characteristic of e-mail?



Secure transmission



B



HyperText HyperText Transfer HyperText Timing Transport Protocol Protocol Protocol



Fast



Expensive



Easy to filter



q_id



q_desc



op1



op2



IN10



Jughead stands for _____________________.



Jonzy's Useful Gopher Hierarchy Excavation And Display



Jonzy's Universal Gopher Hierarchy Excavation And Display



IN11



A channel name in Internet Relay Chat begins with a _______.



+



$



IN12



SDCC stands for _________________.



IN13



WAISMAN is written using _____________.



C



Toolbook



C++



Java



B



IN14



Which program is required to unzip a ".zip" file in Windows?



Unzip



Zip



WinZip



ZipUnzip



C



IN15



DHTML stands for ________________.



Designed HyperText Markup Language



B



IN16



Which of the following language for Internet applications is used for carrying information?



HTML



DHTML



XHTML



XML



D



IN17



An ASP.NET file has the file extension ___________.



.aspx



.asp



.net



.aspnet



A



Secure Direct Client Safe Direct Client to Client to Client



op3



op4



Jonzy's Universal Jonzy's Universal Gopher Hierarchy Gopher Hierarchy Excavation Area Excavation Area Display Download *



#



Self Direct Client to Segregated Direct Client Client to Client



Defined HyperText Dynamic HyperText Divided HyperText Markup Language Markup Language Markup Language



ans



B



D



A



q_id



q_desc



op1



op2



op3



op4



ans



IN18



Dial-up connection is _____________.



Analog



Digital



VoIP



Either A or B



A



IN19



SONET stands for _______________________.



Serial Optical Networking



Subscriber Optical Networking



Symmetric Optical Networking



Synchronous Optical Networking



D



IN20



.org TLD is used for ________________.



Organizations



Profit-making organizations



Non-profit organizations



None of the above



C



IN21



ICANN stands for __________________.



Internet Corporation for Assigned Names and Numbers



Internal Corporation for Assigned Names and Numbers



Intranet Corporation for Assigned Names and Numbers



Internet Committee for Assigned Names and Numbers



A



IN22



In Internet, OSI model contains _______ layers.



4



5



6



7



D



IN23



NNTP stands for _______________________.



Network News Transport Protocol



Network News Transfer Protocol



Network News Transmission Protocol



None of the above



B



IN46



IN47



In EDI, ___________________ define the procedural format Transaction Control and data content requirements for specified business Standards transactions. In EDI software, every EDI sender and receiver should have an EDI ________.



Translator



Transaction Set Standards



Compiler



Data Dictionary and All of the above Segment Dictionary



Interpreter



None of the above



B



A



q_id



q_desc



op1



op2



op3



op4



ans



IN48



The main advantage of EDI is that it helps in reducing ________________.



Paper based document transfer system



Corruption



Service time



None of the above



A



IN49



Electronic commerce that is conducted between businesses is referred to as _______.



B2C



C2C



B2B



C2B



C



IN50



The _____________ of EDI sends and receives transmission files to and from the trading partners either directly or by using party service called VAN.



Application Service



Communication Service



Translation Service



File Service



B



IN51



Which of the following is not a type of Electronic Payment?



Credit Cards



Electronic Cheques



Electronic Purses



Cash Payment



D



IN52



EDIFACT stands for _________________________.



EDI for Administration, Commerce and Transport



IN53



An API _____________________________.



EF1



The process of electronically filing Income Tax returns through the Internet is known as ________.



E-marketing



E-Filing



E-Learning



None of the above



B



UTN stands for ___________.



Universal Transaction Number



Unique Transmission Number



Unique Transaction Number



Ultra Toll Numeric



C



EF2



EDI for EDI for Accounting, EDI for Accounting, Administration, Commerce and Commerce and Text Commerce and Transport Techniques Logically attaches Is a library of Filters calls by Provides network portions of file functions that processes on one I/O to remote file systems on remote provide an interface host to be systems NFS server to local to the transport executed on



A



A



q_id



q_desc



op1



op2



op3



op4



ans



EF3



____ form is for individuals having income from Salary / Pension / Family Pension or Interest income.



ITR-2



ITR-1



ITR-3



ITR-4



B



EF4



__________ is the Annual Salary Statement issued by the employer.



Form No. 15



Form No. 15A



Form No. 16



Form No. 16A



C



EF5



In case digital certificate is not used to file tax return, ITR-V is to be mailed to the Karnataka ITD within _______ days of transmitting the data electronically.



15



20



30



60



C



EF6



Which of the following is not a benefit of E-filing?



Accuracy



Duplication



Security



Convenience



B



EF7



ITR stands for ____________________.



Independent Tax Return



C



Married persons Individuals having Companies Individuals who are filing a separate income from a _________________ are required to file tax return on paper. requiring statutory partners in a return, and live in a proprietary audit u/s 44AB partnership firm community business or



B



EF8



Indirect Tax Return Interest Tax Return Income Tax Return



EF9



SRN stands for ___________.



Service Request Notification



Service Return Number



Service Request Number



Storage Request Number



C



EF10



__________ refers to the deduction in respect of medical treatment.



Section 80DDB



Section 80E



Section 80G



Section 80C



A



q_id



q_desc



op1



op2



op3



op4



ans



EF11



Which of the following statement is incorrect?



SSL stands for Secure Sockets Layer.



SSL is a global standard security technology.



SSL is all about encryption.



SSL is not used in E-filing.



D



EF12



The Income Tax Return form launched by Income Tax Department is known as ________.



Saral



Suraj



Sarat



None of the above



A



EF13



____refers to the deduction in respect of interest on loan taken for higher education.



Section 80D



Section 80C



Section 80E



Section 80GG



C



EF14



Which of the following form is for individuals who are partners in a partnership firm?



ITR-1



ITR-2



ITR-3



ITR-5



C



EF15



_______ is a form that is received from all the payers who have got their tax deducted.



Form No. 16



Form No. 15



Form No. 15A



Form No. 16A



D



EF16



Which of these is also known as ITR-Acknowledgement?



ITR-2



ITR-V



ITR-5



ITR-X



B



EF17



Which of the following a user cannot do while filling an income tax return electronically?



Leave optional fields blank



EF18



Which of the following is not a way of filing an income tax return?



By furnishing the return in a paper form



Add more rows in Make multiple Delete sheets from multi-row copies of their the utility, if not schedules, if Excel utility and required required save them for By furnishing the By furnishing a barNone of the return coded paper return above electronically under digital



C



D



q_id



q_desc



op1



op2



op3



op4



ans



EF19



How many copies of the ITR-1 form need to be filled and submitted to the ITD?



1



2



3



4



A



DS1



Any mark made with the intention of authenticating the marked document is called ______________.



Authentication mark



Signature



Evidence



Digital Signature



B



DS2



The writer of a signature is a _____________.



Writer



Signer



Signatory



Both B and C



D



DS3



Which of these is not present in a Digital Certificate?



Issue date



Expiration date of the public key



Name of the issuer



Digital Signature of the issuer



A



DS4



CA stands for ________________.



Certification Authority



Centralized Authority



Caller Authority



None of the above



A



DS5



__________ are used by individuals when they exchange messages with other users or online services.



Server Certificates



Developer Certificates



Personal Digital Certificates



None of the above



C



DS6



Benefits of digital signatures include __________.



Authentication



Integration



Efficiency



All of the above



D



DS7



_____ serves the ceremonial and approval functions of a signature and establishes the sense of having legally consummated a transaction.



Server Certificate



Cryptography



Affirmative Act



Legal Act



C



q_id



q_desc



op1



op2



op3



op4



ans



DS8



CRL stands for ___________.



Certificate Renovation Lists



Certified Revocation Listing



Certificate Revocation Lists



Certified Remedial Lists



C



DS9



The cost of establishing and utilizing certification authorities, repositories, and other important services, as well as assuring quality in the performance of their functions is referred to as _________________.



Institutional prospect



Company expense



Institutional overhead



Implementation overhead



C



DS10



The recipient of the digital certificate uses the ________ listed in the certificate to verify that the digital signature was created with the corresponding private key.



Public key



User key



Private key



Key certificate



A



DS11



______ helps the verifier to determine if the digital signature Company stamp on User stamp on the Time-stamp on the was created during the operational period. the digital signature digital signature digital signature



Digital stamp on the digital signature



C



DS12



The digital certificate that offers assurance of verification of the owner's personal identity is of _________ level.



Class 1



Class 4



Class 3



Class 2



D



DS13



In Digital Certificates, the prospective signer holding the corresponding private key is termed as the __________.



Recipient



Subscriber



Subject



Server



B



DS14



__________ are on-line databases of certificates and other information available for retrieval and use in verifying digital signatures.



Re-storage



Repositories



Recipients



Data records



B



DS15



While downloading software from Internet, Developer Certificate is used in conjunction with ___________________ technology.



Microsoft AuthorityTM



Microsoft software key



Microsoft Authentication message



Microsoft AuthenticodeTM



D



q_id



q_desc



op1



op2



op3



op4



ans



DS16



In Digital Signatures, ____________ refers to any act of disclaiming responsibility for a message.



Authentication



Integrity



Repudiation



Efficiency



C



CA38



ODBC stands for _____________.



Other Database Connection



Open Database Clients



Open Database Connectivity



Open Data Cost



C



CA39



In __________ check ,it is checked that data entry follows a particular order while checking the records.



Limit



Sequence



Range



None of the above



B



Gaps testing



Summing and Totalling



Digital Analysis



B



CA40



Under Data Analysis Techniques, _________ identifies missing Duplicates testing sequential data.



CA41



__________ is a computer aided audit tool.



IDEA



ACL



MS-Excel



All of the above



D



CA42



In the context of system tests, hybrid tests are



Top down tests



Bottom up tests



A combination of both



None of the above



C



CA43



Under Data Integrity related updated protcols, whenever monetary transactions are processed against master files, the update program should maintain a ______________ to record such transactions that does not have a matching master file



Transaction account



Master account



Suspense account



Sequence account



C



CA44



The Core Image Comparison audit technique compares the ________________.



Database with master table



Executable program with secure master copy



Transaction data with master transaction



Module programs with snapshots



B



q_id



q_desc



op1



op2



op3



op4



ans



CA45



The sample data created and used for the purpose of testing the application system is called ___________.



Test data pack



Table data



Item data



Record data



A



CA46



The stream of test data generated with test tools such as correctness proof, data flow analysis and control flow analysis, is called _______________.



Test item block



Test data pack



CA47



The step involved in Review Methodology wherein when an auditor expands the extent of substantive tests to determine the impact of defects on the attainment of program objectives, it is called as __________________________.



Cross reference listing



Formulating flaw hypotheses



CA48



The purpose-written audit programs are used for ______________________.



CA49



The audit functions of attributes sampling, variables sampling, stratified sampling are included in __________ functions.



Sorting, creating, Data retrieval, code and printing files comparison



Stratification



Selection



Test program pack Test record pack



B



Correct listing



Formulating correct hypotheses



B



Reading data, selecting and analyzing information



Specific tasks with original or modified programs



D



Statistical



Reporting



C
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